Operator’s Manual

Freely Accessible and Adjustable Keyboard with Mouse Pad for Client with Cerebral Palsy

By:
Nolan Skop
Stephen Heussler

Team No. 6

Client Contact:
Miriam Kurland
Hampton Elementary School
380 Main St., Hampton, CT 06247
(860)455-9409
Important Safety Instructions

The Freely Adjustable and Accessible Keyboard with Mouse Pad (FAAKMP) should be kept clean at all times. When cleaning the device make sure the USB is not connected to the computer and no power is provided to the keyboard. When the keyboard is opened wires can be exposed and proper precautions is necessary. An electrical current can be dangerous to the user and the device itself when cleaning improperly. When the keyboard top is open, compressed air or a vacuum hose can be used to remove any debris from around or under the keys. Also cleaning devices such as a dry cloth and Q-tip can be used. If necessary, keyboard cleaning fluid can be purchased. The cleaning fluid is usually composed of diluted isopropyl alcohol. Only a few drops of this fluid onto the cloth or q-tip is necessary; too much cleaning fluid can damage the components and short out a circuit.

When leaving the keyboard plugged into the computer over extended period of time, be sure to turn off the LEDs with the switch located in the front of the device. Do not expose the keyboard to any extreme temperatures (keep within 32 to 100 deg. F) Also do not expose the keyboard to any external devices besides a computer.

All components of this device are non toxic and environmentally safe. However, it is strongly advised not to put any parts in or near the mouth. If swallowed contact emergency help immediately.

Do not eat or drink near the keyboard, as particles may damage or corrode the components of the keyboard. If food particles are dropped inside the keyboard, be sure to clean immediately to prevent build-up. If liquid is spilled inside the board, open the top and allow it to dry before cleaning. Before cleaning, always unplug the device to prevent damage to the keyboard.

Many components in this device are electrical. Be sure to keep any magnetic devices away from the keyboard, as they could cause damage to the microprocessor and other parts.

Dropping the keyboard repeatedly can cause some of its components to become lose, and/or ineffective. Though it may be durable, be careful when handling this device.
Parts and Accessories:

Keyboard controller

PVC external case (top cut-out above)

PCB Board

LED Switch

Cherry MX key switches (55)

0.7x0.7 inch key caps (55)

1.45x0.7 inch key caps (3)
Diodes (55)

101Ω resistors [brown-black-brown]  (7) Orange LEDs (7)

Other accessories used:

- Black wire
- Screws
- Nuts
- PVC glue
- Gorilla Glue
- Rubber Sheeting
Features

The Freely Adjustable and Accessible Keyboard with Mouse Pad has several unique features that differ from the standard computer keyboard. These features are meant to assist people with motor function disabilities such as cerebral palsy.

This device connects to the computer via a USB connector. Most standard keyboards connect with a PS/2 cable that needs to be inserted into the back of the computer tower. With a USB connector, the cable can be easily installed through the front of the desktop or side of the monitor (if applicable).

The FAAKMP contains a seven key mouse pad located towards the bottom right. These keys allow the mouse to move up, down, left and right on the keyboard. The other three keys can left click, right click, and double click. The sensitivity of these keys can change with the software. The speed of the mouse pointer keys can be slowed down or sped up to accommodate the user. These keys replace all the functions a mouse is capable of. Also if the “Shift Lock” key is pressed, the four mouse directional buttons will become the arrow keys seen on standard keyboards. This will allow the user to easily scroll through documents. The mouse pad is highlighted by orange LEDs.

Another feature the keyboard has is the previously mentioned “Shift Lock” button. This button performs a task similar to both the shift key and caps lock key found on standard keyboards. It allows the user to switch between “layers.” By pressing the “Shift Lock” key, letters can become upper-case, and other keys can become characters as seen in the superscript on the board itself. Also previously mentioned the mouse pad directional keys will become arrow keys. By pressing the “Shift Lock” key again, the layer will once again toggle back to its original layer. All keys are followed by a diode that prevents ghosting. In other words, if a key were to be held down for a period of time, multiple characters would not appear. Also multiple keys hit at the same time will not produce multiple characters on the screen.

The keys on this keyboard are spaced out farther than on a standard keyboard. This allows for higher accuracy, especially in users that type with one hand. It also can
tilt up with a greater angle than standard keyboards. This can accommodate users that prefer to type at a more straight forward angle than straight down.

The casing is made of durable PVC material that can be cleaned easily. Also the key switches are Cherry-MX switches as opposed to rubber dome switches. Cherry-MX is much more durable and has a faster tactile response, for quicker, easier typing.
Table of Contents:

1 Introduction
   1.1 General Overview of Device - 8
   1.2 Step by step instructions on using device - 13

2 Maintenance
   2.1 Electrical - 69
   2.2 Mechanical - 69
   2.3 Environmental - 70

3 Technical Description
   3.1 Electrical - 26
   3.2 Computing - 47
   3.3 Mechanical - 52

4 Trouble Shooting
   4.1 Soldering - 71
   4.2 Programming - 75
1 Introduction

1.1 Overview

In this section, a detailed description of each part of the design will be provided. The project can be divided up into two sections, electrical and mechanical. This section will begin with the electrical parts: switches, PCB, Control Board, and other electrical components. Then a description of the mechanical aspect will be described, which can be encompassed by describing the design of the external case. Let us now begin with the section on the switches.

Figure 1. Keyboard

1 shows the completed freely accessible keyboard with mouse pad. The main components are labeled in Figs. 2 and 3 on the next two pages.
Figure 2. Keyboard Internal Parts
Figure 3. Keyboard External Parts
Figures 3A and 3B show side views of the keyboard with the cover on and off.

Figure 3A. Side View of Keyboard
Figure 3B. Side View of Keyboard (top removed)
As can be seen from the two figures, there are not many components that need to be tested with the keyboard. When first using the keyboard, the client should plug in the USB Cable to an available USB outlet on the computer or laptop. Figure 4 below gives an example of the USB Cable being plugged in.

Figure 4. USB Cable being plugged in
After the keyboard is plugged in, the computer should recognize it automatically and it should be functional. To test each key, open a Word document and test each key by pressing each key down. Refer to Fig. 5 below.

Figure 5. Key being tested (note: cover should normally be on)
After testing the keys, the mouse pad should be tested. Figure 5 below shows an image of the mouse pad. The arrows should move the mouse in the direction they are pointed in, and “left click” refers to the left mouse button, “right click” refers to the right mouse button, and “double click” refers to double clicking the left mouse button.

Figure 6. Mouse Pad
Once the keys have been tested, it is important to test the “shift lock” key. Figure 7 below has the shift lock key highlighted.

Figure 7. Shift Lock Key
When the keyboard is in the second layer, all the letters should be capitalized. The keys with two symbols will refer to the top symbol. The mouse pad should also act as an arrow pad. When the keyboard is in the first layer, the green light on the control board will be lit up (Fig. 8). When it is in the second layer, the red light should be lit up.

Figure 8. Control Board in first layer
After all of the keys have been tested, it is important to test the LEDs that are under the mouse pad. Figure 9 below shows an image of the on/off switch. The up position should turn the LEDs on, and the off switch should turn the LEDs off. Try flipping the switch a couple of times to make sure it is working.

Figure 9. Front View of Keyboard with LED switch in view
The LEDs when lit up should be noticeable. Figure 10 below shows a close up of the LEDs with the top of the keyboard removed.

Figure 10. LEDs under Mouse Pad
This keyboard also has lift supports on the back that can raise the keyboard at an angle. Figure 11 shows the back of the keyboard with the lifts.

Figure 11. Back of Keyboard with Lifts
To raise the keyboard, simply turn the lifts until they are orthogonal to the desk. Figures 12 and 13 show the keyboard raised to an angle with the lifts extended.

Figure 12. Front View of Keyboard at an angle with Lifts extended
Figure 13. Side View of Keyboard with Lifts extended
If there is any need to access the interior of the keyboard, the top cover can be removed relatively easily. It is attached with four flathead screws, which are labeled in Fig. 14 below.

Figure 14. Top Cover with Screws Labeled
To remove the top cover, simply unscrew the four screws and lift the cover up and off. Figure 15 below shows an image of the keyboard with the top cover removed.

Figure 15. Internal Keyboard
If there are any problems, after opening the keyboard one should first check the control board, pictured below in Fig. 16.

![Control Board](image)

**Figure 16. Control Board**

First make sure that the female header receptacles (connect the control board to the PCB) are secured firmly. Second, make sure the USB Cable is attached firmly to the control board. This should fix any problems that have been occurring.
3 Technical Description

3.1 Electrical Description

In this section, a detailed description of each part of the design will be provided. The project can be divided up into two sections, electrical and mechanical. This section will begin with the electrical parts: switches, PCB, Control Board, and other electrical components. Then a description of the mechanical aspect will be described, which can be encompassed by describing the design of the external case. Let us now begin with the section on the switches.

Switches

One of the most important components of the keyboard are the switches used in the design. These must very durable and long lasting, so the keyboard will last a long time for the client. After much deliberation, it was decided that Cherry MX Switches were the best choice for the keyboard. These are very durable switches that are made to be mounted in a printed circuit board. Listed below are their features, and following this are their specifications:

Features:

- Desktop profile, 0.60 inch (15.2mm) from PCB (no keycap)
- Choice of feel: linear, soft tactile, click tactile
- PCB or frame mount
- Long life: 50 million operations (linear) and 20 million operations minimum (tactile)
- 4mm travel
- LED, diode or jumper option
- 12V maximum AC/DC
- Current Rating: 10mA
- Insulation Resistance: <100MΩ at 100V DC

---

1 Cherry Corp. Website
Specifications

**Electrical**

Voltage: 12 VAC/DC max.
2 VDC min.

Current: 10mA AC/DC max.
10µA DC min.

Insulation Resistance: 100MΩ at 100V

Initial Contact Resistance: 200mΩ (25mΩ typical)

Bounce Time: ≤5msec (at 16 in/sec. actuation speed)

Capacitance: <2pF (at 1kHz)

Operating Temperature: -10°C to +70°C

Storage Temperature: -40°C to +70°C

Flammability Rating: UL94HB

**Materials**

Case: Thermoplastic

Contacts: Silver-Gold?? (AuAg 10)

Spring: Stainless Steel

Solderability: Wave solder, 5 seconds at 500°F

As can be seen, these are very durable keys. These switches have an actuating force of approximately 2N. The maximum force they can withstand is not defined in the data sheets, however it is estimated that a force of at least 100N can be sustained by a switch (well suitable for the purposes of our device). A diagram of the Cherry MX switches used is shown in Fig. 7 on the next page.
Figure 17. Cherry MX switches, side and top view. The dimensions are displayed both in inches and in millimeters.  

Figure 18 below shows an image of the Cherry MX switch mounted on a PVC backing.

Figure 18. Cherry MX switch with PVC backing and photo
The printed circuit board is the backbone of the design. The switches and other electrical components are all mounted on it, and it is through this that the signals are sent to the control board. It was very important that the design of the PCB was accurate, because it is very expensive, and once it was ordered, it had to be used.

To design the PCB, Express PCB software was used. It was very intuitive software, and took little time to master the program. The PCB was to be centered around the switches, and pads are created for the switches. Figure 19 below shows a diagram made in MS Visio of the dimensions of the pad to be inputted into Express PCB.

Figure 19. Switch Hole Positions
The switches follow a matrix of rows and columns, following the outline of Figure 20 below.

**Figure 20. Switch Matrix**
Every switch was placed one inch apart, to correspond with our design. The wiring of rows and columns is somewhat challenging, but by using the bottom and top layers, every row and column was connected successfully.

As the design of the PCB developed, so did the design of the keyboard. The next step in the PCB design incorporated the new switch layout, along with running the rows and columns into the correct outputs. Figure 21 below shows how the rows and columns were to be output from the PCB.

![Figure 21. Inputs for Control Board](image)

Only the shaded holes were to be utilized on the control board. This meant that the rows and columns had to be wired to these holes. Figure 24 on the next page shows the output pads from the PCB, to be wired to these inputs.
LED backlighting could not be incorporated into the entire keyboard, so another option had to be chosen. It was decided to put LEDs only behind the mouse pad. This is the most important aspect of the keyboard, so it seemed...
fitting to have those keys illuminated through LED backlighting.

To save area, the PCB outline was also changed. Along with saving room, this also acted to make the PCB cheaper in cost.

The LED circuitry of the mouse pad of the PCB can be seen in detail below in Fig. 223.

![Figure 23. Arrow Pad on PCB](image)

It is obvious that the wiring is very “busy” in this area. Many wires are crossing, and it was not easy to accommodate every row and column. To go from one layer to another, vias (small filled holes) were used in many
places. Without the use of vias, this circuit could not have been created.

The final design of the PCB had many changes overall. The circuit was condensed as much as possible to save space and money. Figure 28 on the next page shows the finished PCB that was ordered from Express PCB.
Figure 24. Final PCB Design
Figure 25 below is a picture of the PCB that should be the same as the one found inside the keyboard.

Figure 25. PCB
All the electrical components are soldered to the PCB. This is an arduous task, but can be completed successfully in a timely fashion. Figure 26 below shows the PCB with everything soldered to the board.

Figure 26. PCB with soldered components

Current is also passing through the LEDs, which is how they are lit up in this picture.

Figure 27 on the next page shows the control board which is wired to the PCB.
Figure 27. PCB with Control Board

Figure 28 on the next page shows a front view of the PCB. From this picture the height of the switches can be seen.
Figure 28. Front View of PCB
Diodes

Diodes were implemented into the design of the keyboard to eliminate “ghosting”. They are placed in between the switches and the control board. When a key is depressed on a normal keyboard, it will keep registering until the key is elevated. For our client, this is a major problem. For example, sentences that he types will normally look like this. By utilizing diodes, this is prevented. No matter how long a key is depressed, it will only register once. Figure 34 below shows an image of a normal diode.

Figure 29. Diode
**LEDs**

To illuminate the keyboard and make it more aesthetically pleasing, LEDs were incorporated into the design. At first it was planned to have LEDs behind every switch, but as was explained in the PCB section, this was not plausible. Instead, LEDs are incorporated behind the arrow pad of the keyboard.

The basic circuit of the LEDs is given below in Fig. 35.

![LED Circuit](image)

Figure 29. LED Circuit.

It is a very simple circuit in which a resistor is placed in between the voltage source and the LED, so that too much current does not pass through the LED. On the next page in Fig. 29, the LED circuit used in the design is shown.
This circuit is the same as fig. 29, except there is a potentiometer in between the voltage source and the LEDs. In the final design, the potentiometer was replaced with a switch. This allows the client to turn the LEDs on and off.

To figure out the correct resistors to use, Kirchoffs voltage equation was used.

\[ V = IR \quad \text{Equation 1} \]

In this equation, \( V \) stands for voltage, \( I \) for current, and \( R \) for the resistance of the resistor. The voltage in our design was taken from the USB connection, and was 5 volts. The voltage drop of our LEDs was 2.4 volts, and the LED current rating was about 20mA. Equation 2 below shows the equation that was used to find the correct resistance.

\[ \text{Resistance} = \frac{\text{Voltage of supply} - \text{LED voltage drop}}{\text{LED current rating}} \quad \text{Equation 2} \]

Solving gives a resistance of 330 ohms. On the next page in Figure 37 is an image of the LED circuit being tested on a protoboard.
Figure 31. LED circuit.

Figure 32 on the next page shows an image of the LED circuit functioning on the PCB.
Figure 32. LEDs on PCB

Figure 33 on the next page is an image of the LED circuit on Express PCB.
The voltage comes in through the resistor, passes through the LED, and then goes to ground. The top wires are the incoming voltage from the USB connection, and the bottom connects to ground.
Figure 34 below shows an image of a common LED.

LED’s (light emitting diodes) are semiconductors and contain a material that has varying ability in conducting electricity. The material used is usually aluminum-gallium arsenide, AlGaAs. There are two layers of the LED, one containing negatively charged particles and one containing positively charged particles. When current passes through the LED properly, that is the positive charged particles are connected to the negative end of the battery, the zone in between (depletion zone) gets larger. This effect coupled with a specific arrangement of electrons produces light.
3.2 Computing Description

Control Board

The control board that was used in this design was purchased from PI Engineering. Figure 41 below shows an image of the control board.

![Control Board Diagram](image)

Figure 35. X Keys Control Board (PI Engineering)

The thirty-pin header on the bottom of the board receives the current from the various switches when they are triggered. This header allows for one hundred and twenty eight keys, many more than were needed. The holes, labeled with a “C#” or “R#”, represent the columns and rows of the keyboard respectively. The control board is connecting the CPU through a USB connection, which also provides the 5V power source. In the center of the board is a microprocessor. This device was programmed to fit the keyboard’s specific needs.

This integrated circuit is 2 inches by 2 inches and has four mounting holes to secure it. As mentioned
earlier, the control board connects directly to the computer using a USB connection. The Cherry MX switches connect to the control board through a double row Female Header Receptacle (see Fig. 34 below). Once the switches are all wired to the control board (see Fig. 35 for wiring layout), the microprocessor was programmed to interpret each of the incoming signals.

Figure 36. Female Header Receptacle

Figure 37 on the next page shows an image of the control board with a single switch connected.
To connect the control board to the switches, the female header receptacle had to be wired to the control board inputs. Referring to fig. 38 and the inputs figure below, each input point can be determined.

Figure 38. Inputs
Wires were soldered to the PCB and then connected to the female header receptacles. Figure 39 below shows a picture of the wires and the connections.

Figure 39. Wiring
To program the control board, the software that was included with the matrix board was used. This is called “Macro Works”. Figure 40 below shows the basic screen of the program.

Figure 40. Macro Works
Each box in the picture represents a row and column point. The program that was used for the keyboard contained five rows and thirteen columns. There is also a layer toggle key, so each switch has two functions. The mouse pad acts to control the mouse in layer 1, and layer 2 it acts as arrow keys. Each letter key has a lowercase and uppercase option, and miscellaneous symbols are included on the number keys.

The control board is also able to eliminate “ghosting” through the use of the diodes used on the PCB. When our client presses and holds a key down, it only registers it once. This was a problem our client was having which is solved through the use of this keyboard.

3.3 Mechanical Description

External Case Design

The five row keyboard front-view is shown on the next page in Fig. 41.
The whole case is made from PVC, so the next step would be to cut out the key holes. The keys and their dimensions can be seen in Fig. 42 below.
Figure 42. Keys and Dimensions

The hole size can also be seen in fig. 41.

The center of each hole was determined using Visio in fig. 43 below.

Figure 43. Hole Centers
Figure 44 below shows an image of the keys with their hole outlines around them.

As can be seen, the diameter of the milling bit was to be 0.15 inches.

Figure 45 on the next page shows an image of the expected top piece cutout.
To cut out the PVC, the milling machine was programmed with the help of people in the machine shop to cut out each individual hole at exact positions. The end product can be seen in Fig. 46 on the next page.
Figure 46. Top Piece Cutout

Figure 47 on the next page shows a side view of the top piece, and Fig. 48 shows the top piece with the keys in between the cutouts.
Figure 47. Top Piece Side View
Figure 48. Top Piece with Keys
The bottom cut-out is constructed of a double layer of PVC glued together using PVC Cement. This enables holes to mount the switch, PCB, and to mount the top piece. Figure 48 below shows the Visio image used to model the switch PCB and control board on the bottom piece. Figure 49 then shows the holes that were drilled.

Figure 49. Bottom Piece
Figure 50. Bottom Piece w/ Holes

The bottom piece was then given a final model with nothing imposed on it in fig. 51 on the next page.
The PVC was then milled and the holes were at the correct position. To mount the switch PCB, mounting pieces were cut out to a height of 0.70", and were threaded to fit screws with a machine thread of 6-23. The top piece mounts using spacers with a height of 1.0".
Figure 52A below shows the finished case with the mounting spacers screwed in.

Figure 52A. External Case Bottom
Figure 52B below shows an image of the case with the top placed on.

Figure 52B. External Case with Top

Figure 53 on the next page shows a front view image showcasing the spacers and how the PCB was mounted.
Figure 53. Front View of Case
As can be seen, the two layers of PVC act for support and for room so the top of the screws can be flush with the rest of the case. Figure 54 below shows a side view of the case, with the keys included.

Figure 54. Side View with Switches

Figure 55 on the next page shows a picture of the PCB mounted to the bottom piece of the PVC.
Figure 55. PCB Mounted on Bottom PVC

As can be seen in this image, the PCB is very securely connected to the bottom piece.
The last step in the construction of the case was to add the supports to raise the case at an angle. This was done by putting supports on the back of the keyboard. Figure 56 shows an image of this.

As can be seen, when the supports are extended the case raises at a certain angle. The supports were made of two pieces of PVC glued together using PVC cement. The height of the supports is 3 inches.
2. Maintenance

2.1 Electrical Maintenance

The USB cable should provide a long life for this keyboard. However with all electronic devices, several precautions should be taken. Keeping the device clean is necessary to its longevity. If the keyboard needs to be cleaned due to a spill or food being dropped between the key switches, be sure to use measures for cleaning. When cleaning the device make sure the USB is not connected to the computer and no power is provided to the keyboard. When the keyboard is opened wires can be exposed and proper precautions are necessary. An electrical current can be dangerous to the user and the device itself when cleaning improperly. When the keyboard top is open, compressed air or a vacuum hose can be used to remove any debris from around or under the keys. Also cleaning devices such as a dry cloth and Q-tip can be used. If necessary, keyboard cleaning fluid can be purchased. The cleaning fluid is usually composed of diluted isopropyl alcohol. Only a few drops of this fluid onto the cloth or q-tip is necessary; too much cleaning fluid can damage the components and short out a circuit.

2.2 Mechanical Maintenance

The keyboard is a very durable device; however there are certain precautions that must be taken when handling it to ensure its longevity.

Too much force applied to the keyboard can destroy the casing over time and damage some the electrical components. They case should be kept clean. It is encouraged wiping the case with a dry or slightly damp cloth every few weeks to prevent dirt buildup. All screws on the keyboard should be kept tight to ensure that the keyboard never opens up unexpectedly.

2.3 Environmental Maintenance

This device is meant for indoor use only. Do not use this device with outdoor computers. Components are non-biodegradable. Therefore, if a part breaks or is no longer functioning, be sure to discard appropriately. In order to maintain proper function of the keyboard, it should be kept
within room temperature. Too high or too low of temperatures can destroy certain components.

This device is designed to type on a computer, which will save trees. This in turn offsets the effects of global warming. Trees are able to take Carbon Dioxide out of the atmosphere. By saving trees, carbon dioxide will be removed from the atmosphere.

Because there has only been one of these keyboards made however, this device alone will not stop global warming. In case of this global catastrophe, and the sea levels rising, do not use the device as a flotation device. The PVC can be hazardous to baby seals. Also, do not use the device to club baby seals.

None of the parts on this keyboard are edible, so please do not feed any parts of the keyboard to animals. In case of an oil spill, do not use the keyboard to wipe off the oil from the animals.
4 Trouble Shooting

If key switches, wires, LEDs, or resistors become lose, they may have to be resoldered. Soldering the electrical components again should establish the connection again. When soldering follow the six steps below. (Taken from “How to Solder” http://www.aaroncake.net/electronics/solder.htm)

Step 1: Equipment

Soldering requires two main things: a soldering iron and solder. Soldering irons are the heat source used to melt solder. Irons of the 15W to 30W range are good for most electronics/printed circuit board work. Anything higher in wattage and you risk damaging either the component or the board. Note that you should not use so-called soldering guns. These are very high wattage and generate most of their heat by passing an electrical current through a wire. Because of this, the wire carries a stray voltage that could damage circuits and components. The choice of solder is also important. One of the things to remember is to never use acid core solder. Acid core solder will corrode component leads, board traces and form conductive paths between components. The best solder for electronics work is a thin rosin core solder. I prefer a thickness of 0.75mm, but other thicknesses will also work. Just remember not to get anything too thick.

Remember that when soldering, the rosin in the solder releases fumes. These fumes are harmful to your eyes and lungs. Therefore, always work in a well ventilated area. Hot solder is also dangerous. Be sure not to let it splash around because it will burn you almost instantly. Eye protection is also advised.

Step 2: Surface Preparation:

A clean surface is very important if you want a strong, low resistance joint. All surfaces to be soldered should be cleaned with steel wool and some sort of solvent. Lacquer thinner works well. Some people like to use sand paper, but I think that it is all too easy to sand right through circuit board traces, so steel wool is my preference. Don't neglect to clean component leads, as they may have a built up of glue from packaging and rust from improper storage.
Step 3: Component Placement

After the component and board have been cleaned, you are ready to place the component on the board. Bend the leads as necessary and insert the component through the proper holes on the board. To hold the part in place while you are soldering, you may want to bend the leads on the bottom of the board at a 45 degree angle. Once you are sure that the component is properly placed, you can move on to the next step.

Step 4: Apply Heat

Apply a very small amount of solder to the tip of the iron. This helps conduct the heat to the component and board, but it is not the solder that will make up the joint. Now you are ready to actually heat the component and board. Lay the iron tip so that it rests against both the component lead and the board. Normally, it takes one or two seconds to heat the component up enough to solder, but larger components and larger soldering pads on the board can increase the time.

Step 5: Apply Solder And Remove Heat
Once the component lead and solder pad has heated up, you are ready to apply solder. Touch the tip of the strand of solder to the component lead and solder pad, but **not** the tip of the iron. If everything is hot enough, the solder should flow freely around the lead and pad. Once the surface of the pad is completely coated, you can stop adding solder and remove the soldering iron (in that order). Don't move the joint for a few seconds to allow the solder to cool. If you do move the joint, you will get what's called a "cold joint". This will be discussed shortly.

**Step 6: Cleanup**

After you have made all the solder joints, you may wish to clean with steel wool or solvent to remove all the left over rosin. You may also wish to coat the bottom of the board with lacquer. This will prevent oxidation and keep it nice and shiny.

**Cold Solder Joints**
A cold joint is a joint in which the solder does not make good contact with the component lead or printed circuit board pad. Cold joints occur when the component lead or solder pad moves before the solder is completely cooled. Cold joints make a really bad electrical connection and can prevent your circuit from working.

Cold joints can be recognized by a characteristic grainy, dull gray colour, and can be easily fixed. This is done by first removing the old solder with a desoldering tool or simply by heating it up and flicking it off with the iron. Once the old solder is off, you can resolder the joint, making sure to keep it still as it cools.

Soldering is something that needs to be practiced. These tips should help you become successful so you can stop practicing and get down to some serious building.

1. **Use heatsinks.** Heatsinks are a must for the leads of sensitive components such as ICs and transistors. If you don't have a clip on heatsink, then a pair of pliers is a good substitute.

2. **Keep the iron tip clean.** A clean iron tip means better heat conduction and a better joint. Use a wet sponge to clean the tip between joints.

3. **Double check joints.** It is a good idea to check all solder joints with an ohm meter after they are cooled. If the joint measures any more than a few tenths of an ohm, then it may be a good idea to resolder it.

4. **Use the proper iron.** Remember that bigger joints will take longer to heat up with an 30W iron than with a 150W iron. While 30W is good for printed circuit boards and the like, higher wattages are great when soldering to a heavy metal chassis.

5. **Solder small parts first.** Solder resistors, jumper leads, diodes and any other small parts before you solder larger parts like capacitors and transistors. This makes assembly much easier."

If you need to install the software (Macro Maker) because the program was uninstalled or needs to be
installed on a different computer follow the directions seen in Figure. *

Figure* : Installing and Uninstalling Macro Works

To Installation:

1. Insert the X-keys Macro Works CD into an available CD drive.
2. The installation program will automatically start. Select Install Macro Works.
3. Follow the installation instructions when prompted.
4. Reboot computer. The computer must be rebooted after installation for proper function.

To uninstall:

1. Select Add/Remove Programs from the Control Panel.
2. Locate X-keys Macro Works* in the list and select it.
3. Click Remove and follow any instructions when prompted.

*Make sure “X-keys Macro Works” is selected and not “X-keys”.

Figure* : Installing Macro Works

After installation a the program can be opened from the icon “Macro Maker”. When opened a diagram similar to the one below will appear. The second tab to the right will bring up the Matrix necessary to program the computer. If altering a program open the document from the File tab.
To program the device use the pull-down menus from the header. Keys can be programmed in many different ways. If there is a problem the “Help” tab can be used and a diagram like the one below can be used.
Programming a Key

Select a key to program by clicking it with the mouse, it will highlight green or red depending on the layer selected. Right click on the key and select either Create/Edit Macro, Mouse Click, Mouse Pointer, Scroll, Layer Shift key, Game Controller Button, Copy/Cut Key, Same as Green Layer (on the red layer) or Clear or access those same options from the Macro menu. The following describes each of these different choices:

Select Create/Edit Macro to program keystrokes into keys, jgile/steer knob or joystick. When chosen the Create/Edit Macro form will appear. Enter a description in the Caption field if desired. This is purely informational. Click Start and enter the desired keystrokes for the macro. Click Step. If satisfied click OK. For better programming clicking OK after the Start button is the same as clicking Step then OK. Continue on for all keys. Remember to Save the file periodically by either clicking the Save icon on the Standard toolbar or selecting Save from the File menu. See Create/Edit Macro help for more details.

Select Mouse Click to have the key execute a mouse click when pressed. Left, Right, Center and Double Click are available. One click (or double click) is executed when the key is pressed as if to send multiple clicks it must be repeatedly pressed.

Select Mouse Pointer to have the key or joystick execute mouse pointer movement by the specified number of mickeys. Program the key to either move Right, Left, Up, or Down. After selecting a direction the Mouse Pointer Mickeys form will be displayed. Enter the number of mickeys to move. 1 is the smallest increment, 127 is the largest.

Select Scroll to have the key execute a scroll command when pressed. Scroll Up, Scroll Down, Ctrl Scroll Up, Ctrl Scroll Down, Alt Scroll Up, Alt Scroll Down, Shift Scroll Up and Shift Scroll Down are available. One scroll is executed when the key is pressed however if it is held down it will continuously send scrolls until released.

Select Layer Shift Key to program a key to change layers. Xkeys have 2 layers, green and red, which can contain different mouse actions. The current layer of the Xkeys device is indicated by the LED's, see instruction manual for location. In order to access the second layer at least one key must be programmed as a Layer Shift Key. Momentary will change the layer to the opposite layer while the key is pressed and return it to the original layer when released. Toggle will change to the opposite layer each time it is pressed. In addition Set to Green and Set to Red are provided which will always set the layer to green or red regardless of the current layer was.

Select Game Controller Button to program the key to function as a game controller button. The FT Virtual Joystick supports 16 game buttons, point of view hot and joystick Y, X and Z. After clicking the Game Controller Button you will be prompted to assign the button number, point of view or joystick axis. If a joystick axis is selected pressing the Xkeys button will result in that axis going instantly to full scale. To test these buttons start Macro Manager with a layout that includes game buttons. Select Settings > Control panel from the Start menu and then select Game Controllers. The FT Virtual Joystick will be a choice (if not then Macro Manager is not running or there was an installation error). Click the Properties button and make sure the Test tab is showing. The buttons, joystick and point of view hot will respond to the programmed Game Controller Buttons.

Select Copy/Cut Key to program a button to be a Copy, a Cut or a Protected Cut key. This function allows Xkeys to store multiple clipboard items from applications that use the standard Windows clipboard. Unfortunately many applications have proprietary clipboard formats. In these cases the Copy/Cut keys will not work as intended. Some amount of experimentation is needed. To use the Copy/Cut feature at least one key must be programmed as a Copy key, several keys may be Clip or Protected Clip keys. When Macro Manager is running if a Copy key is pressed and held down and a Clip key is pressed (Copy+Clip) the selected items are first copied to the Windows clipboard, by sending the Ctrl+C keystrokes, and then "saved" to that Clip key so that thereafter when that Clip key is pressed the "saved" clipboard is pasted, by sending the Ctrl+V keystrokes. In this manner several clipboard items can be in use at once along with the Windows clipboard itself. If an application does not use the Ctrl+C keys for copying or the Ctrl+V keys for pasting the Copy/Cut will not work. The Protected Clip key is much like a regular Clip key but once something has been "pastalted" it cannot be pastaled again. The first time Copy+Protected Clip is detected a warning box will ask for confirmation. If confirmed the key will not be able to be "pastalted". To clear a Protected Clip key launch Macro Maker with the desired layout. This can be done directly from Macro Manager by clicking on the Layout and selecting Edit Layout or by flipping the Xkeys program switch from the operate position to the program position. In Macro Maker click on the Protected Clip key to clear and select Copy/Cut -> Protected Clip again. This will clear the flag and allow the key to be pastaled again.

Select Same as Green Layer to copy the contents of the green layer key to its corresponding red layer key. Keys may also be programmed by importing a file, see Import.
Clearing a Key

To clear an entire key, click on the picture of the key and select Clear from the choices. This clears out the key for the currently selected layer only. To clear either a press or release macro only, select Create/Edit Macro from the choices then select the macro to clear by checking the Release checkbox appropriately (press macro is unchecked) and click the Start button then the Stop or OK. This clears out the macro.

If you need to edit a key a similar fashion using the Help tab can assist you in the process. Figure * demonstrates this.
Once a layout has been created and saved it may be assigned to a device for use. There are several ways to choose a layout. The first way is useful for users who are connecting to only one device or only one of each type of device. This would apply to the Freely Accessible and Adjustable Keyboard. Start Macro Maker and open the desired layout using the Open tab from the File menu. The filename will be displayed in the title bar of the main window and the graphical representation will automatically change to the device of the layout. Select Assign to Device from the File menu. At this point the device does
not need to be connected. If a layout is already assigned, the user will be prompted to overwrite the assignment with this layout. Open Macro Manager icon to initiate the connection of the device. A window such as in Figure * will appear.

![Figure *: Macro Manager - using a device](image)

No Devices Detected
Section 10: References


[12] “How to Solder”
http://www.aaroncake.net/electronics/solder.htm